The Role a Motivational Agent plays:
The Effects of a Co-learner Agent and an Expert Agent

Yao Yu
s1603590
First Supervisor
DR. J. KARREMAN

First Supervisor
PROF.DR.M.DE JONG

UNIVERSITY OF TWENTE
FACULTY OF BEHAVIORAL, MANAGEMENT AND
SOCIAL SCIENCES, COMMUNICATION STUDIES
Master Track Technical Communication

1

Acknowledgement
First of all, I wish to express my sincere gratitude to my supervisors Dr. J. Karreman and Dr.
M. De Jong who have given me their patient instructions, helpful assistance, constructive
correction and recommendation throughout whole period of my study. I give deep appreciation
to all lecturers in Communication Science at the University of Twente for their inspiration and
support in making the master study program a success.
I also give thanks to all my friends who supported me during this year. With their help, I finally
finish the master thesis within limited time. Finally, I would like to thank my family for
standing behind me.

2

Abstract
Purpose: Expert-like agents and co-learner agents are two kinds of most commonly used
pedagogical agents in a computer based learning environment. An experiment is conducted to
find out whether there were differences in terms of learners’ performance and their perceived
motivation level when they used instructions with agents playing these two roles. Furthermore,
participants’ perceptions of the agents are investigated.
Method: An experiment was conducted to test the effect of co-learner and expert agent
implementation. The dependent variables are users’ perceptions of agents, task performance,
motivation level and the user experience of the instructions. 60 Participants were divided
randomly into three groups and were requested to perform a same task in Photoshop with a
designed instructions containing the different agent. For group 1 and 2, the instructions only
contained an expert-like agent or a co-learner agent separately while for group 3 the
instructions contained both these two types of agent. Participants were asked to fill out an
online questionnaire to indicate their opinions about the instructions after the initial task
performance and then were requested to repeat the task without instructions.
Results: The results of this study show no differences between the three participant groups in
initial and repeated task performance. The results show a difference in motivational level;
compared to an expert-like agent, the implementation of a co-leaner agent lead to higher level
of satisfaction among users. Furthermore, participants’ perception of an agent differed due to
the role they play. An expert-like agent is deemed to be more credible and knowledgeable
while a co-learner agent is perceived as being more friendly and attractive.
Conclusion: Agent role serves as an important part of agent design that needs to be taken
serious consideration since the implementation of different agents proved to have an impact
on users.

Keywords: expert-like agent, co-learner agent, task performance, motivation, agent perception,
user experience
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1. Introduction
With the advance of technology, we now are capable of designing computer-based learning
environments to support simulated social interactions between learners and computers. This
great change has facilitated the development of agents, which is used as a metaphor, referring
to characters, often human-like, which appear on screen (Erickson, 1997). Agents guiding
users through learning environments are known as pedagogical agents: “animated life-like
characters embedded in instructional applications” (Yanghee Kim & Baylor, 2006a).
Pedagogical agents can be seen as an endeavor to simulate social contexts in which people
typically achieve goals through collective efforts in their daily lives, thus contributing to create
more realistic environments for users to acquire knowledge. For example, the implementation
of a mentor-like agent will be helpful in creating a class-like learning environment in which
students are instructed and encouraged by their teacher.
There are many researches that have investigated the effect of pedagogical agents. As a kind
of motivational element, the implementation of pedagogical agents introduces more
instructional support throughout the process of learning (Clark & Choi, 2005).According to
Baylor, the advantages of implementing agents are quite obvious since “it is most convenient
or timely for a learner”(Baylor, 2011). Furthermore, the application of a pedagogical agent
may “facilitate learners to engage in the learning task and consequently to enhance learning in
computer-based environment” (Yanghee Kim & Baylor, 2006a).
Researches in this field have also explored whether or not the factors influencing human to
human communication are still effective when employed in agent based environment. As
described in Kim and Baylor’s research (2006) of customizing agent-based social models,
design constituents of pedagogical agents needed to be taken into consideration such as
interaction type, appearance, affect, competency and so on. These features are strongly related
with or influence the instructional role represented by agents.
Just classmates and teachers in students’ real lives, pedagogical agents can help to facilitate
the process of learning of users by playing various roles in instructions, like expert (W. L.
Johnson, Rickel, & Lester, 2000), tutor (Graesser, Chipman, Haynes, & Olney, 2005), mentor
(Baylor & Kim, 2005a), learning companion or even trouble maker (Aimeur & Frasson, 1996).
In a multimedia learning environment, agents can be classified into two categories on the basis
of their mastery of relevant knowledge. The first type of agents could serve as “mastery model”;
agents who are capable of playing the role as mentors or experts. They are usually highly
competency, having acquired enough knowledge about the whole system, demonstrating the
desired level of performance. The second type of agents have a lack of knowledge or
experience about the task, sharing the same questions with learners and can be seen as the
students’ avatars, playing the role of co-learners or peer in the system. This kind of agents
serve as “coping model” with low competency (Baylor, 2011). Researches have shown
differences between these two agent models. For example, according to Ebbers (Ebbers, 2007),
a coping model agent enhanced great motivational outcomes as compared to a mastery model
agent. Kim and Baylor (Yanghee Kim & Baylor, 2006b) also found in their research that low
competency models are more influential in terms of “enhancing self-efficacy beliefs”. Since
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agents’ mastery level of knowledge is strongly related with their role designing, these
conclusions are also applicable when comparing the effects of agent role.
Arguably, expert-like and peer-like agents are most commonly implemented among all the
roles(Baylor & Kim, 2005).The detailed effects of these two agent stereotypes are still to be
discovered. The application of mentor agent conforms to a traditional learning environment,
in which teachers serve as the medium for knowledge transfer. The deduction is easily made
that with more enriched domain knowledge, expert-like agents are inclined to be more credible
and persuasive. However, as the agent who shares similar problems with the user, co-learner
agents may help arouse stronger emotions so that users may feel more motivated and confident;
this finally leads to a higher level of satisfaction.
In the former two studies, it was found that distinctions did exist among participants working
with a peer-like agent and those instructed by expert-like agent with respect to learners’ taskrelated attitudes, performance and agent perceptions (Rosenberg-Kima, Baylor, Plant, & Doerr,
2008; Veletsianos, 2010). According to Veletsianos, participants working with a peer-like
agent had better performance and tended to give higher ratings to the agent. Rosenberg-Kima’s
research, however, focused more on task-related attitudes of participants and the conclusion
was drawn that peer-like agents can be more effective in terms of enhancing the learner’s selfefficacy as well as raising their enthusiasm while expert-like agents had a greater influence on
learners’ beliefs in the subject domain. Baylor also conducted an experiment in which a
comparison among three pedagogical agent roles was made. It was pointed out that compared
to an expert agent that only provides information, the agents with motivation, namely
motivator agent and mentor agent, were more engaging and facilitated learning better.
However, the expert agent was found to be the most credible one and led to a significantly
better performance on the transfer measure (Baylor, 2003). In another research led by Liew,
Tan and Jayothisa (2012), the effects of peer-like and expert-like agents were studied.
Nevertheless, expectations such as peer-like agent can enhance participants’ self-efficacy,
expert-like agent are perceived to be more knowledgeable are not supported. Thus, these two
agent stereotypes’ effects on users are still uncertain.
On the other hand, with the popularization of multiple agent implementations, the possibility
raises for peer-like agents and expert-like agents to coexist in one instruction system. Since a
comparison will be made between these two stereotypes, will learners’ perceptions of each
agent role alter? Will participants be more motivated? And will their learning achievement
differ from single agent systems that include an only peer-like agent or expert-like agent?
The reason for choosing this topic is that despite the fact that agent stereotype serves as a very
important part of agent designing, studies focusing on this field are still very limited, especially
when it comes to a multi-agent system. In this study, an experiment will be conducted, aiming
at confirmation and further extending of earlier research findings. This research may help to
deepen understanding of pedagogical agent role, thus promote the agent designing.
The proposed research will firstly analyze the assumptions of earlier researches about
pedagogical agents, the design of the agent and various agent roles implemented as well as
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their impact on users. The experimental part will investigate the specific effects of an
instructional system with one agent playing the role of an expert or a co-learner as well as an
instructional system in which the expert-like agent and peer-like agent coexist. By comparing
and analyzing the results, the research aims to find the differences made by agent stereotype
implementation.

2. Theoretical Framework and Research Questions
The framework is divided into two parts: In the first part, the basic theory of pedagogical agents
including its definition and its theoretical foundation will be explained. In the second part, the
focus will be on specific agent roles.

2.1Pedagogical agents and its theoretical basis
As a kind of motivational elements, pedagogical agents are widely applied to inspire users.
The implementation of pedagogical agents has created a social simulated environment in
which users are encouraged to have interactions with computers. The design of pedagogical
agents involves numerous aspects with direct impact on user’s perception of agents or attitudes
toward tasks. Moreover, the pedagogical agent system also can be classified into the singleagent system and multi-agent system. According to research, the number of agents containing
in a system serves as an important and influential factor.

2.1.1 Motivation and Motivational Elements
The definition of motivational elements is, as Loorbach stated, the “textual additions or
modifications to user instructions aimed at motivating the reader to keep on reading and trying
long enough to perform the desired procedure correctly”(Loorbach, Steehouder, & TAAL,
2006, pp. 10–15). A good instruction, should be in pursuit with a motivational sub-goal along
with the main instructive goal so that users are ensured to be motivated to keep on working
when they are confronted with setbacks(Karreman & Loorbach, 2013).
However, motivation is a complex concept hard to be defined. To better define the
motivational design, the ARCS model is developed and widely applied as a measurement of
motivation (Keller, 1987, pp.1-10). Based on the ARCS model, the motivational elements
should be aimed at enhancing attention, relevance, confidence or satisfaction. The
classification is somewhat artificial due to the reason that these categories are highly
interrelated. Motivational elements aimed at one category are of great possibility to fall into
other categories as well(Karreman & Loorbach, 2013).
As motivation plays a vital role in effective technical communication, introducing motivational
elements in instructional documents is of great value (Goodwin, 1991). For example, Goodwin
stated in his book that readers should be encouraged to continue reading a manual in spite of
various obstacles (Goodwin, 1991, p.99). A similar view is advocated by Horton, who claimed
documents enhanced by motivational elements as “seductive documents”. He pointed out that
technical writers should handle drawing readers’ attention so that they can notice and act on
the information by creating more seductive documents (Horton, 1997). Furthermore, the
importance of motivation elements could be embodied through the fact that International
Organization for Standardization (ISO) defines usability as “the extent to which a product can
be used by specified users to achieve specified goals with effectiveness, efficiency and
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satisfaction in a specified context of use.” Satisfaction, which supports users to have a
continuing desire to learn and thus maintain high motivation, are included as an essential
element in usability along with effectiveness and efficiency(Karreman & Loorbach, 2013; Van
Der Meij, Karreman, & Steehouder, 2009). It serves as an important proof against those who
attaches all the value of a manual to its correctness only.
Based on the assumption that users usually experience a lack of patience when dealing with
complex and tedious instructions and easily get frustrated when in face of setbacks,
motivational elements are applied to raise users’ interest, inspire them as well as boost their
confidence. With the aim of facilitating positive experiences during the process of performing
tasks, motivational information mainly focuses on users’ attention, their feelings about the
relevant tasks and their level of confidence(Loorbach, Karreman, & Steehouder, 2007).
Instructions inducing motivation should provide not only insightful instructions but also
pursue an impression of concise and entertaining.
Several studies have been made to prove the positive effects of motivational elements have on
users. It is demonstrated that users do appreciate motivational elements. By implementing
motivational elements and information, there’s a possibility to enhance participants’
performance and help them to become more persistent when facing challenging
tasks(Loorbach et al., 2007).
There are various types of motivational elements with different targets based on the ARCS
model, aiming at attracting attention, increasing the feeling of relevance or booming
confidence(Karreman & Loorbach, 2013). For example, motivational elements like distinct
colors or pictogram are mainly used to improve attention level of users while the
implementation ofanecdotes aim at improving relevance level. Furthermore, to satisfy users’
desire for social interaction, the strategies of influencing users’ affect and showing sympathy
can be applied, such as the implementation of pedagogical agents (Van de Meij, 2008).

2.1.2 Pedagogical agents
According to the social cognitive perspective on teaching and learning, social interaction is of
great importance in terms of motivational outcomes (Vygotsky, Cole, John-Steiner, Scribner,
& Souberman, 1978). The implementation of pedagogical agents has satisfied users by
providing them a simulated social environment in which communications, as well as
interactions, are greatly encouraged, thus can be seen as an endeavor to introduce more
instructional support. As a kind of motivational elements(Clark & Choi, 2005), pedagogical
agents are defined as animated life-like “designed to enhance learning and motivation by
simulating social interaction with a learner”(W. L. Johnson et al., 2000; Y. Kim et al., 2007).
Learners can get information and knowledge through interacting with PALs (Pedagogical
Agents as Learning Companions), who may provide an indication, encouragement or
collaboration.
However, arguments always exist in terms of the specific effects of pedagogical agent
implementation. On the one hand, compared to conventional courseware, pedagogical agents
included in instructional application can provide social interactions with learners and are
proved to be heAlpful to overcome some constraints on computer-based learning(Yanghee
Kim & Baylor, 2006b). Since researches have demonstrated that social interaction serves as a
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key point of influencing learners’ cognitive and affective characteristics, pedagogical agents
may help users to become more engaged in learning tasks by simulating human
instructional roles and providing consistent interaction(Skinner & Belmont, n.d.). The
advantage of implementing agent can also be proved by Moreno’s research, in which learners
exposed to an environment with a pedagogical agent demonstrated better learning
achievement and higher motivation level than learners without an agent(Moreno, Mayer,
Spires, & Lester, 2001). While on the other hand, there are concerns that the presence of
pedagogical agents can distract leaners from the learning content (Dehn & van Mulken,
2000).Just as Heidig and Clarebout stated in their studies, the majority of researches on
pedagogical agents’ effect of facilitating learning yielded no difference(Heidig & Clarebout,
2011). To give a clear explanation of this phenonmenon, it is vital to find out under what
conditions can pedagogical agents facilitate learning. It was pointed out in their study that
despite the uncertainty, factors such as learning environment, learner characteristics, and the
pedagogical agent’s function might influence the final outcomes of agent application. While
in most studies, only the designing of pedagogical agents are concerned to be of great
importance.
To create a social context for learning, pedagogical agents are designed to possess human-like
personae under normal circumstances(H. Johnson, Nigay, & Roast, 1998). As for the detailed
design of agent, it is never an easy task because many factors, as well as their mutual influence,
need to be taken into consideration. In general, factors frequently concerned in pedagogical
agent design include gender, ethnicity, multiplicity, visual image, verbal and nonverbal
communication. In some specific cases, for example, when a peer agent acts as a co-learner in
a system, the competency of agents serves as an important factor (Yanghee Kim & Baylor,
2006a). There are plenty of researches focusing on each detailed factor of agent designing, and
many conclusions have been drawn to refine the design for different groups of users. Just as
Baylor pointed out in her research (2011), users are more inclined to be influenced by agents
with same gender and ethnicity. Furthermore, the “appearance and message delivery together
with the dialogue are key design considerations” for an agent(Baylor, 2011). Appearance,
which serves as the most important aspect of designing, plays a major role in the effectiveness
of agents. As a complex factor, appearance is influenced by many factors such as the gender
of the agent, its visual image, the level of realism and even the gender of users. For example,
it is proved that the most effective agent among female undergraduate should be equipped with
following features such as being a young, attractive and cool female(Baylor, 2011). On the
other hand, message delivery through a human-like voice with appropriate emotional
expressions is also vital in terms of design feature because emotion is proved as a part of human
intellectual and cognitive functioning (Kort, Reilly, & Picard, 2001). Meanwhile, body
movements like gestures, the facial expression can convey enriched information and draw
learners’ attention(Baylor & Kim, 2000). In general, “the credibility of these agents build trust
relies on the visual quality of the agent and the behaviors that emulate humans”(Mora-Torres,
Laureano-Cruces, Gamboa-Rodríguez, Ramírez-Rodríguez, & Sánchez-Guerrero, 2014).
The design of agents remains to be the possibly most complex issue. Many factors still need
to be further studied with respect to the agent's voice, the role of nonverbal communication
such as deictic gestures. Based on previous studies, Heidig and Clarebout have put forward a
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subordinate model which enable a systematic review of formal studies: Pedagogical AgentsLevels of Design (PALD) in their research(Heidig & Clarebout, 2011). They organize the
different design features on three levels, including global design level as the lowest level,
medium design level and detail design level as the highest level. They also mentioned that in
this model, “decisions on a higher level presuppose decisions on a lower level”. As the figure
shows, agent roles, together with determining features, directly determines the most detailed
factors like agent age, gender and so on.

Figure 1 Pedagogical Agents- Levels of Design model (PALD)

2.1.3 The multiplicity of agents
A promising possibility in terms of regulating pedagogical interventions is the instantiation of
multiple pedagogical agents in a learning environment(Baylor, 2002).The introduction of
multiple agents has been widely applied since it is proved in researches that the use of
multiple anthropomorphic agents can improve learning achievement (Xiao, Zhong, & Yuhui,
2004)
Bandura pointed out that learners may develop stronger beliefs in their ability to learn when
they are exposed to multiple social models (Bandura, 1977). To apply this principle, an
instructional environment may include multiple agents with varying perspectives or domainspecific skills, representing distinct agent. By separating agents functionally, it would be easier
10

for students to compartmentalize the agent information when it is delivered by different
sources. Baylor and Ebbers have also proved in their research that splitting agent roles into
two distinct agents is preferable to combing those roles into one agent (Baylor & Ebbers, 2003).
Hietala and Niemirepo (1998) point out in their study that the same social factors occurring
in learning communities with human beings are also influential in a learning community
consisting of multiple artificial teaching and learning agents. They suggest that by providing
alternatives to the learner via an “extended family of intelligent agents”, the learning process
can be effectively simplified. According to Baylor, “by designing a cle ar delineation of roles
in the two-agent condition, learners’ cognitive load requirements were reduced, deriving a
more efficient learning situation(Baylor & Ebbers, 2003).
Schunk, Hanson and Cox (1987) tried to investigate how peer models influenced achievement
behavior among children. They pointed out that compared to children who observe a single
mastery model, those with single copying model, multiple coping model, and multiple mastery
models demonstrated higher self-efficacy and better performance. This finding further proves
that the effects of pedagogical agents can never be completely decided by a single factor. It is
always the comprehensive function of all factors working together and influencing each other.

2.1.4 User Experience and Pedagogical Agent
Although user experience is a concept that has been widely disseminated and accepted in the
field of Human-Computer Interaction, it is still not clearly defined (Law, Roto, Hassenzahl,
Vermeeren& Kort, 2009). This is mainly because of the wide gap between practitioners and
academics in their understanding of what user experience is. Though, in industry field, the user
experience is treated mainly as a synonym of usability, its differences from usability is
emphasized academically (Hassenzahl, 2008). However, the close connection between
usability and user experience can never be denied. According to Herzum (2010), user
experience includes peoples’ behaviors, attitudes, and emotions about using a particular
product, device or software. In general, user experience includes both usefulness and usability,
which was measured according to ISO 9241-11 by the effectiveness, efficiency, and
satisfaction of use. On the other hand, as a kind of motivational elements, pedagogical agents
are proved to be effective in terms of improving satisfaction level. Therefore, despite the fact
that researches focusing on the relationship between the implementation of agent and user
experience are very limited, the deduction can still be made that user experience is possible to
be improved by introducing agents since pedagogical agents areproved to effective in terms of
enhancing learning performance and improving motivation.

2.2 The Instructional Role of Pedagogical Agent
Since pedagogical agents serve as an endeavor to simulate the social environment, the agent’s
persona and associated role is of great importance. Since people tend to apply the same social
rules and expectations from human-human interaction to computer-human interaction, the
agent roles are mostly from real-life learning environment and the effect of agent roles can
also be explained by theories developed in terms of human instruction (Ericsson, Krampe, &
Tesch-Romer, 1993). Given their function for supporting learning, pedagogical agents can be
designed to represent different instructional roles such as expert, instructor, mentor, learning
companion. To design effective pedagogical agents more vividly, different types of human
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metaphors have been adopted. Traditionally, the expert tutor is the most widely used role in
giving instructions. Many agents are developed as expert-like image such as the agent
AutoTutor which plays the role of tutor (Graesser, Person, Harter& Group,2001) as well as the
Steve and Adele agents which represent experts in the domains of military trainings (Johnson
et al., 2000). Meanwhile, there are increasing studies designed to focus on learning companion
agent role by adopting a peer metaphor, which is also applied in former tutoring systems
(Goodman, Soller, Linton, &Gaimari, 1998; Kapoor& Picard, 2005). The implementation of
expert-like tutor agent and the co-learner agent has perfectly simulated the most common
learning environment in which each leaner is tutored by tutors with rich knowledge and
simultaneously surrounded by the peer with similar levels of ability. As the two kinds of most
typical agent role in the instructional system, expert-like agent and co-learner agent would be
the focus of this study.

2.2.1 Co ping model vs. Mastery model
The main character strongly related to agent role is its mastery level of knowledge. Agents
with strong professional background usually play the role of expert, mentor, taking
responsibility of giving instructions, or sometimes as a highly competitive co-leaner who
serves as a challenge for users. While agents with limited experience of relevant field are more
frequently designed as peer or co-learner with low competency. Ebbers has put forward two
types of an anthropomorphic interface agent model: mastery model and coping model (Ebbers,
2007). This is based on the formal studies on therapeutic contexts in which modeling is used
to reduce avoidance behaviors in fearful clients (Thelen, Fry, Fehrenbach, & Frautschi, 1979;
Schunk, Hanson& Cox,1987). Mastery model agents demonstrate positive attitudes towards
the task and the desired levels of performance. This type of agent model “cheerfully and easily
learns the information, demonstrating high self-efficacy in the process” (Ebbers, 2007) The
copying model is an endeavor to model for the learners how to cope with a situation as a novice,
demonstrating the typical fears and deficiencies of observers initially but gradually gain selfconfidence and improve performances (Kazdin, 1978) . It “initially struggles with the material
but is capable of building mastery gradually through the expressed use of coping and learning
strategies” (Ebbers, 2007).
When being exposed to a mastery agent, learners should perceive it as dissimilar to them since
it can learn the materials effortlessly and enthusiastically. With a dissimilar social comparison
to the mastery model agent, learners would be expected to seek to disaffiliate with that model.
A mastery agent can help learners to achieve more positive learning performance outcomes.
However, the implementation of mastery model agent can also cause the anxiety in the form
of negative mood in learners. It is also possible that mastery model agent is of great effects in
terms of helping users to get greater cognitive dissonance and finally lead to lower regulation
(Festinger, 1962).
Conversely, the results indicate that when in a computerized human-agent learning
environment, the coping agent can lead to more positive social learning outcomes among users.
Learners with coping model agents are more likely to see them as “true partners” for the reason
that coping model agents share the same struggles with them. Therefore, users’ anxiety tends
to be more easily diminished and thus it will lead to more positive affect, motivation, attitudes
and behaviors (Festinger, 1962). Ebbers found out that working with coping model can help
12

to enhance motivational outcomes as compared to be with mastery agents. Baylor also pointed
out in her research that if the agent is caring and acts as a coping model, motivational and
affective outcomes maybe enhanced(Baylor, 2011).
Similarly, PALs can be designed to achieve different levels of competency depending on the
theoretical perspective. When with high-competency agents, learners can grow intellectually
beyond the limits of their present capabilities. Since high-competency agents have already
acquired rich knowledge in the relative domain, learners can take advantage of their knowledge
and experience. However, the high competency PALs might decrease a learner’s self-efficacy
beliefs in the task. It has been proved by Aimeur and Frasson (1996) that learners’ affective
characteristics including self-esteem, sense of responsibility and confidence were significantly
enhanced when they work with peers who were academically weaker than themselves in
computer-based environments.

2.2.2 Expert-like agent
Expert-like agents are agents with the feature of an expert, with higher than average mastery
level of knowledge in one domain. Expert agents mainly take the responsibility of providing
instructions, serving as an instructive role rather than a supportive role in a system(Baylor &
Kim, 2005b). It has been pointed out in Van de Pol and her colleagues’ research that the
evaluation criteria of a qualified human teacher comes down to two factors: the expertise and
personality (Van de Pol, Volman, & Beishuizen, 2011). As Veletsianos (2010) put forward in
his book, agents playing an expert role may positively influence learners’ stereotypic
perceptions and expectations of the agent. With a high mastery level of knowledge,
pedagogical agents resembling experts are usually perceived as intelligent and competent (Kim,
Baylor, & Reed, 2003). Being an expert is firmly related to exhibiting extensive knowledge
or better as well as a more stable performance within a domain (Gonzales, Burdenski, Stough,
& Palmer, 2001). It is known that for a human being who wants to develop expertise in a
certain domain, several years of deliberate practice is required (Ericsson, Krampe, & TeschRomer, 1993). By implementing an expert-like agent in a system, learners tend to assign higher
confidences and trust to instructions. Since pedagogical agent role is based on realistic social
stereotype, expert-like agents are usually designed as a role with confidence and will “not
swayed emotionally by instant internal or external stimulation”(Baylor & Kim, 2000). In
consideration of these features attached to this role, expert agents are usually designed with
the visual image of professors dressed in a suit. Furthermore, the expert-like agent must speak
in a formal and professional manner, with very few exaggerate non-verbal communications to
make sure it is emotionally detached form leaners.
Despite the shortage of being less supportive, it is believed that expert agents are perceived to
be more credible and more helpful when it comes to transfer of learning(Baylor, 2003).

2.2.3 Co-learner agent
Co-learner agents, or pedagogical agents as learning companions (PALS), are defined as “peerlike characters simulating peer interaction in computer-based learning”(Yanghee Kim &
Baylor, 2006b). As implied by its name, a learning companion is set as a role keeping company
of learners during the process of study. Just as the role a classmate plays in real life, co-learner
agenta share the same information resource with leaners and can be designed to collaborate
13

with or compete against users. Many researches in the field of psychology have proved the
benefits of peer-to-peer interaction over teacher-to-learner interaction theoretically and
empirically (Matusov& Hayes, 2000; Yarrow & Topping, 2001) for the reason that having
social interaction or cooperation with equally able peers is believed to have benefit on
intellectual development, thinking, affect as well as cognitive growth (Matusov& Hayes, 2000).
As Bandura stated, attribute similarity between the learner and social model can have
significant impact on learner’s self-efficacy belief, which serves as a critical component of
learner motivation (Bandura, 1997).The implementation of the co-learner agent is an attempt
to simulate the beneficial interaction in tutoring systems, thus achieve the effect of motivating
users.
As for the relationship between learning companion and leaner, three types of protocols are
presented by Chan and Baskin (1990) including competition, suggestion, and collaboration.
According to the theory, for learner and learning companion who work independently and then
comparing work, their relationship is defined as competition; for those who work
collaboratively with one’s working and the other one’s watching, their relationship is defined
as suggestion and for those working collaboratively and sharing responsibility, the relationship
between them is defined as collaboration. Earlier use of learning companions was mainly
focused on the systems’ learning along with the learners (Yanghee Kim, 2007). While
nowadays, with the development of interface technology, the three relationship goals between
learner and learning companion mentioned above can all be achieved.
When designing a co-leaner agent, besides factors which always needed to be taken into
consideration such as gender, affect, ethnicity, multiplicity and so on, a very unique factor,
namely competency, along with relevant interaction type, is of great value and needs to be
resolved. For example, when a PAL is equipped with instructor-like competency, it will lose
its peer-likeness because “the PAL should be perceived as peer-like and believable”(Yanghee
Kim & Baylor, 2006b). PALs are supposed to be helpful in learning and proving motivation.
However, as Baylor and Kim (2006) pointed out, the high competency of a PAL might
decrease a learner’s motivation. On the contrary, a co-learner agent with appropriate levels of
competency can achieve the better effect of simulating human peer interaction thus further
facilitate learning. This conclusion is also in line with the former research of mastery model
agent and copying model agent.
Another factor that has been studied on co-learner agent is whether being caring will lead to
different feelings of users. To address this issue, Lee and colleagues (2007) conducted an
experiment that employed three conditions: a caring co-learner agent; a non-caring co-learner
agent and a control. They finally demonstrated that students working with caring co-learner
agent had significantly greater feelings of social support and trust. Thus, a conclusion can be
drawn that learners are most motivated when working with a caring co-learner agent with the
appropriate level of competency.

2.2.4 Multi-agent System of Expert Agent and Co-learner Agent
The multi-agent system provides a platform that allow each pedagogical agent “to specialize
on the behaviors for which they are responsible”(Campbell & Wu, 2010). Since different types
of information can be delivered by distinct sources in multi-agent system, it might be easier
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for learners to compartmentalize the information. Baylor and Ebbers (2003) conducted an
experiment in which they used two split agents, a motivator agent and an expert agent, to
replace the mentor, agent. The results showed that compared to a single mentor agent, the
combination of these two agents facilitated learning more effectively by providing learners
with both motivation from the motivational agent and learning support from the expert agent.
They pointed out that by attributing certain types of comments to a certain agent, the cognitive
load of users is largely reduced. It was found in their research that the implementation of these
two agents in one system has great impacts on helping users to recall information in the process
of learning. However, compared to mentor agent, the two-agent system didn’t help much in
terms of users’ motivation level.

2.3 Hypotheses
Since there are limited researches focusing on pedagogical agent’s role and its effect on users,
this study aims to further investigate and confirm existing research results. To better
investigate the persona effects of the pedagogical agent, the research question raised as:
What’s the pedagogical agent role’s effect on users?
Task performance
 1a). Participants with a co-learner agent will have a higher level of effectiveness
compared to participants with an expert agent or two kinds of agents simultaneously in
the task completion phase.
 1b). Participants with both a co-learner agent and an expert agent will have a higher
level of effectiveness compared to participants with an expert agent or participants with
a co-learner agent in the task repetition phase.
 1c). Participants with both an expert-like agent and a co-learner agent will spend longer
time on finishing the task compared to participants with only an expert agent or a colearner agent in the task completion phase.
Motivation
 2a). Participants with a co-learner agent and with both a co-learner agent and an expert
agent will have a higher level of motivation compared to participants with an expert
agent only.
 2b). Participants with a co-learner agent will have a higher level of confidence than
participants with an expert agent and participants with both a co-learner agent and an
expert-agent.
 2c). Participants with a co-learner agent will have a stronger feeling of relevance than
participants with an expert agent and participants with both a co-learner agent and an
expert-agent.
 2d). Participants with a co-learner agent will have a higher level of satisfaction than
participants with an expert agent and participants with both a co-learner agent and an
expert-agent. .
 2e). Participants in multi-agent groups will have a lower level of attention then
participants with a co-learner agent and participant with an expert agent.
Agent perception
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 3a). Participants will give higher ratings to the co-learner agent when co-learner agent
and expert agent coexist in a system.
 3b). Participants with only a co-learner agent will have a different perception of this
agent than participants with a co-learner agent and an expert agent.
 3c). Participants with only an expert agent will have a different perception of this agent
than participants with a co-learner agent and an expert agent.
User experience
 4). The participants with a co-learner agent will report better user experience compared
to participants with an expert agent and participants with both a co-learner and an expert
agent.

3. Methodology
3.1 Experimental Design
Based on pedagogical agent design and the effect of different agent role found by prior
researches, an experiment was conducted to test expert-like agent and co-learner agent’s
impact on users.
During the research study, participants were asked to perform a task in Photoshop, which
included four sub-tasks with the help of printed instructions. Participants were divided into
three groups with each group containing 10 female and 10 male. There were pedagogical
agents presented in the instructions for each group. While for group 1, it was an expert-like
agent giving instruction and reminding participants of some complex steps. For group 2, the
pedagogical agent was designed as a caring co-learner who gives encouragement at an exactly
same place where the expert-like agent gives remind. In the manual prepared for group 3, the
expert-like agent and co-learner agent coexisted.

3.2 Material
According to former studies, learners are more inclined to be influences by agents with same
gender as them(Baylor, 2011), which means participants should be matched with agents with
their gender in an ideal case. However, since agents’ gender is not a dependent variable in this
research, the decision had to be made in the selection of agents’ gender. Since it is widely
recognized that female agents are acceptable both for male and female students, the agents in
this study were designed as female. For the expert-like agent, the visual appearance resembled
a female lecture while the co-learner agent was designed as a female college student in her 20s.
Additionally, both agents were designed to give an introduction at the beginning of the
instructions so that users could get an overall impression on them. The expert agent, named
Kate, introduced herself as an expert with abundant experience in using Photoshop. The peer
agent, Kelly, however, introduced herself as a novice of using Photoshop. The following
figures show the visual images design of expert agent and co-learner agent.
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Figure 2 expert-like agent

Figure 3 co-learner agent

The instructions were based on a tutorial from an online blog that instructed users to change
the background of an image by using channel method in Photoshop. To ensure the instructional
effect of the manual, the level of complexity of the task was controlled within the normal range.
Because of the limitation that agents applied in this experiment were in the static state, all
information provided by agents were through their verbal communication and visual image
only to make sure that no other factors influenced the experiment. Participants’ completion
status of tasks and the time each participant spent on tasks were all recorded.
After performing tasks, participants were asked to fill out a questionnaire using ranking
methods in which they evaluated the quantified levels of their motivation, satisfaction with
the system and gave opinions or some additional comments on the motivational agents.
In the instructions, the expert-like agent was designed with typical features of an expert, that
is, knowledgeable, having confidence and mainly provide information only. While the colearner agent is designed as a learning companion with same mastery level of knowledge.
Despite the lack of experience, the co-learner agent tended to be very caring and tried to
motivate participant by giving encouragement all the time.
The comparison of these two types of agents can be seen as the following example, which was
excerpted from the instructions in which the expert-like agent and co-learner agent coexist.

Refining edge of the selected subject is very helpful to improve the
quality of final outcome. As you can see, you have removed the
background of original image perfectly with the help of edge
refinement.

Now we have finished 75% of whole task and we are about to finish
the task successfully!
Let’s work on the final subtask.
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3.3 Measurements
The dependent variables included participants’ performance, their motivation level, their
perceptions of agents they are working with and the user experience of instructions.
For each construct, the Cronbach’s Alpha value was calculated to ensure the reliability of the
collected data.
Learners’ agent perceptions
Four items, each scaled from 1 (strongly agree) to 5 (strongly disagree) measured learners’
perceptions of agent’s attractiveness (I like Kate/Kelly), agent’s friendliness (Kate/Kelly is
friendly), agent’s knowledge (Kate/Kelly is knowledgeable) and agent’s lesson credibility (I
can trust the lesson that is presented Kate/Kelly). (Liew et al., 2013)
The Cronbach’s Alpha of co-learner agent and expert agent were calculated to measure the
reliability of agent perception data.The value of Cronbach’s Alpha of co-learner agent
perception and expert agent perception was shown in the following table:
Table 1 Cronbach's Alpha value of agent perception

Co-learner
.863

Expert
.881

Cronbach’s
Alpha
The high value of Cronbach’s Alpha value of these two constructs shows that the data was
reliable.
Learners’ motivation level: Attention, Relevance, Confidence, and Satisfaction
The self-report measure RIMMS (Reduced Instructional Materials Motivation Survey), a 12item version of the instructional materials motivation survey (Keller, 2009; Loorbach et al.,
2006), was conducted to measure the four constructs of Keller’s ARCS model of motivation
design, which are attention, relevance, confidence and satisfaction. Each item scaled from
1(strongly agree) to 5(strongly disagree).
The Cronbach’s Alpha value of these four constructs was calculated. The result was shown in
the following table.
Table 2 Cronbach's Alpha value of ARCS model

Relevance
.581

Attention
.724

Confidence
.664

Satisfaction
.810

Overall
.832

Cronbach’s
Alpha
According to the results, the values of attention, confidence and satisfaction constructs are all
greater than 0.6, which meant the data of these three constructs was of high reliability.
Although the result of Relevance construct was not high enough, it was very close to the
standard of being reliable. For this reason, the decision was made to take it as valid data.
User experience
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Four items measured learners’ overall experience were conducted, including the level of
positiveness, satisfaction, effectiveness and efficiency. Each item scaled from 1(most negative)
to 5(most positive) (Yang, 2015).
The Cronbach’s Alpha value of user experience was as high as 0.845. Therefore, it’s
convincible that the data of user experience is reliable and can be used for further research
Learners’ task performance
The analysis of learners’ learning achievement mainly depends on two factors, namely
effectiveness and efficiency. By recording whether participants can finish the task successfully
with or without instructions, the time they spent on tasks and which subtasks they stopped
under the condition that they didn’t finish the task successfully, the learning achievement can
be measured. To be noticed, leaners were requested to perform the task twice. They were asked
to perform the task with instructions in phase 1 and repeat the task without instructions in
phase 3. The completion status of both two phases was recorded while the time spent was only
recorded in phase 1.

3.4 Participants
The participants of the research were mainly students from the University of Twente. The
sample consisted of the same number of male and female participants in total and in each group
so that the result of the experiment was ensured not to be influenced by gender or education
level. In this study, 60 participants, 30 males, and 30 females, were divided equally into three
groups, with 10 males and 10 females in each group. All the participants joint the experiment
out of their willing and were requested to finish the task without searching for help. The
education level and average age of participants are listed in the following table:

Table 3 The education level and average age

Gro
up

Expert
Bach
elor

Fem 3
ale
Mal 3
e

Co-learner

Expert and Co-learner

Mas P
ter
h
d
6
1

Aver Bach
age
elor
age
23.2 2

Mas P
ter
h
d
7
1

Averag Bach
e age
elor
23.4

6

22.8

5

23.2

1

3

2

Averag
e age

3

Mas P
ter
h
d
7
0

3

4

23.3

3

21.3

All participants were required to have no experience or very limited experience in using
Photoshop to eliminate the possible influence on experiment’s credibility.
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3.5 Pre-study
Before the formal experiment started, eight participants were asked to perform the task step by
step according to the instruction and give suggestions on how to improve the quality of
instructions. In addition to this, these participants also gave their opinions on the visual image
of pedagogical agents applied in the instructions. Thus, it was ensured that the instructions
were understandable; the task was doable, and the agents were acceptable before the formal
experiment was conducted.
Meanwhile, to enhance the validity, the online questionnaire was tested beforehand carefully
to avoid errors. Clear instructions and simple wording were used to ensure that the results are
valid.

3.6 Procedure
Each participant was asked to finish all the tasks on his or her own in the uninterrupted
environment. He or she was firstly given an introduction of the experiment and asked to sign
a consent form to make sure of the anonymous processing of recorded data. Then the
participant would start to work on the task with the help of instructions. During the process of
experiment, the participant was not allowed to ask any questions about how to perform tasks,
but he or she could choose to stop whenever they felt that they were not capable of continuing
the experiment anymore. Participant’s operation was screen recorded. After finishing the tasks,
the time he or she spent on the tasks was recorded. Whether the participant had finished the
tasks or not, the participant was asked to fill out the questionnaire after performing tasks.
Finally, the participant was asked to perform the whole task again without instructions.
Whether he or she had successfully repeated the task and in which subtask did he or she stuck
was taken noted. In this way, an analysis of the task performance and opinions of the multiagent system can be conducted.

4. Results
This section presents the experiment’s results. Differences in users’ task performance, their
motivation level, the perception of the pedagogical agent they worked with, and the user
experience of the instructions.

4.1 Differences in task performance
Learners’ task performance was measured by two sub-constructs, which were effectiveness
and efficiency. Since participants were required to perform the task firstly with instructions in
phase 1 and then repeat it without instructions in phase 3, the data of effectiveness were
collected both in these two phases. While the data of efficiency were only collected during
phase 1.

4.1.1 Differences in effectiveness
In each group, there were participants who failed in finishing the task with instructions and in
repeating the task without instructions.
11 participants failed to finish the first step of the experiment, which was performing the task
with the help of instructions. Group 1 (participants with instructions containing expert-like
agent only) was with the highest failure rate, 5 participants out of 20 were unable to finish the
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task successfully. While in group 2 (participants with instructions containing co-learner agent
only) and group 3 (participants with instructions containing both co-learner agent and expertlike agent), the occurrence number tied up, with 3 participants failed in each group.
The number of participants who failed to repeat the task without instructions, however, soared
up to 31, with 12 in both group 1 and group 3, and 7 people in group 2. By analyzing the data
mentioned above, it seemed that participants working with a co-learner agent performed best
in terms of effectiveness.
Since the whole task was divided into four subtasks, for those who have failed in step 1 or step
3, data was collected as in which subtask the participant end. Table 4 and Table 5 show the
detailed results for each group in the phase of task completion and task repletion separately.
Table 4 Performance in phase 1

expert

1
1
0
3
15

Which part did the
participant end

Subtask 1
Subtask 2
Subtask 3
Subtask 4
Participants who finished all task

Group
colearner
0
0
1
2
17

Total
Expert
and colearner
0
2
0
1
17

1
3
1
6
49

Table 5 Performance in phase 3

expert
5
4
0
3
18

Which part did the
participant end

Subtask 1
Subtask 2
Subtask 3
Subtask 4
Participants who finished all task

Group
coexpert and
learner
co-learner
3
4
3
5
1
2
0
1
23
18

Total

12
12
3
4
29

To better measure the agents’ impact on effectiveness in phase 1, the mean score was
calculated as shown in Table 6.
Table 6 Mean score of effectiveness in Phase 1

Expert
Total task performance
Number
of
tasks
performed correctly

M
3.50

SD
1.41

Co-learner
M
3.80

SD
0.58

Expert and Colearner
M
SD
3.65
1.16
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As hypothesis 1a stated, participants with a co-learner agent will have a higher level of
effectiveness compared to participants with an expert agent or two kinds of agents
simultaneously in the task completion phase.The results of an ANOVA showed that this
hypothesis was not confirmed (F=0.556, p=0.594). The conclusion can drowns that agent
didn't have an effect on effectiveness.
Table 7 shows the mean score of effectiveness in Phase 3.
Table 7 Mean score of effectiveness in Phase 3

Expert
Total task performance
Number
of
tasks
performed correctly

M
2.25

SD
1.24

Co-learner
M
2.85

SD
0.75

Expert and
Co-learner
M
SD
2.20 0.95

The expectation of effectiveness in the repetition phase was participants with both a co-learner
agent and an expert agent will have higher level of effectiveness compared to participants with
an expert agent or participants with a co-learner agent (hypothesis 1b). The results of ANOVA
test showed no significant differences between three groups (F=0.287, p=0.753). Thus,
Hypothesis 1b was not confirmed.

4.1.2 Differences in efficiency
Efficiency was measured by making a comparison between the time participants consumed in
each group. Participants who did not finish the task were excluded. The ANOVA test was
conducted to measure the difference between the three groups.
Table 8 shows the mean score of effectiveness in Phase 3.
Table 8 Mean score of efficiency

Expert
Total task performance
Number
of
tasks
performed correctly

M
19.60

SD
8.70

Co-learner
M
17.00

SD
5.87

Expert and
Co-learner
M
SD
20.65 8.44

Expectation was made that participants with both an expert-like agent and a co-learner agent
will spend longer time on finishing the task compared to participants with only an expert agent
or a co-learner agent in the task completion phase (hypothesis 1c). While the mean score did
show some tendencies of the hypothesis, the ANOVA test (F=1.168, p=0.318) showed no
significant differences between each group. Thus, hypothesis 1c was not confirmed. Agents
didn’t have a significant influence on efficiency.
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4.2 Differences in motivation level
The motivation design level was measured through the four constructs of Keller’s ARCS
model. Thus, the results of the experiment were analyzed through a univariate ANOVA, with
each construct, namely attention, relevance, confidence and satisfaction, as dependent
variables. The independent variables in the analysis were pedagogical agents.
A univariate ANOVA test was taken to measure the difference among three groups in attention,
confidence and satisfaction constructs separately.
Table 9 shows the mean score of each construct in each group. Group 1 represents the condition
in which participants are instructed by expert agent; group 2 represents the condition in which
participants are encouraged by co-leaner agent; group 3 represents the condition in which
participants are exposed to expert-like agent and co-learner agent simultaneously.
Table 9 The Mean Score of RIMMS

Construct
confidence
satisfaction
Attention
Relevance
Overall

Expert
Mean
SD
Mean
SD
Mean
SD
Mean
SD
Mean
SD

Co-learner
1.9
0.53
2.53
0.81
2.3
0.73
2.12
0.71
2.21
0.59

2.16
0.77
1.98
0.68
2.2
0.63
2.28
0.66
2.17
0.51

Expert and Colearner
2.26
0.63
2.5
0.71
2.33
0.7
2.32
0.57
2.35
0.42

Motivation: It was expected that participants with a co-learner agent and with both a colearner agent and an expert agent will have a higher level of motivation compared to
participants with an expert agent only (hypothesis 2a). Since ANOVA showed no statistically
differences existed (F=0.720, p=0.491). The hypothesis was not confirmed. The
implementation of different agents didn’t affect the overall motivation level of users.
Confidence: It was expected that participants with a co-learner agent will have a higher level
of confidence than participants with an expert agent and participants with both a co-learner
agent and an expert-agent (hypothesis 2b) because a co-learner agent persistently encourages
the users, which would boost their level of confidence. However, a statistical test (ANOVA)
showed no differences between the co-learner agent group and expert group agent group, nor
did it exist between these two groups and the multi-agent group (F= 1.89, p=0.160). Thus, the
hypothesis was not confirmed. The implementation of different agents didn’t affect the users’
confidence level.
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Relevance: It was expected that the co-learner agent group would show a higher level of
relevance compared to the other two groups (hypothesis 2c). According to the results of the
ANOVA test, no significant difference was found between the co-learner group participants
and the other two groups (F= 0.545, p=0.583). The implementation of different agents didn’t
affect the users’ relevance level.
Satisfaction: As hypothesis 2d stated, participants in co-learner agent group would be the most
satisfactory group. Multi-agent group came to the second, followed by expert agent group. As
it shown in table 4, a significant difference was found between three groups (F=3.551,
p=0.035). A Bonferroni post hoc test showed that this was due to a tendency (p=0.089, d=0.23)
toward a difference between group 1 and group 2. Thus hypothesis 2c was confirmed.
Attention: Hypothesis 2e stated that compared to other two groups, multi-agent group users
would show the lowest level of attention because it was possible that they were distracted by
the presentation of two agents. However the hypothesis was turned down as the test showed
no differences among three groups (F= 0.205, p=0.813).

4.3 Differences in Agent Perception
The agent perception was measured through four aspects, namely agent’s attractiveness,
agent’s friendliness, agent’s mastery level of knowledge and agent’s credibility. The mean
score of these four aspects was calculated as the overall perception of the agent. The results of
the experiment were analyzed through a univariate ANOVA.
To measure the differences of agent perception between each group, the ANOVA test was
conducted.
Table 10 shows the mean score of co-leaner agent perception and expert agent perception.
Table 10 Mean score of co-leaner agent perception and expert agent

Expert
Colearner

Exper
t
Mean 2.25
SD
0.81
Mean
SD

Colearner

2.26
0.66

Expert and
Co-learner
2.46
0.77
2.75
0.69

Hypothesis 3a stated, participants will give higher ratings to co-learner agent when co-learner
agent and expert agent coexist in a system.. While as the ANOVA test showed, there was
indeed a significant difference between the two agents perception under the condition that both
agents coexist in the instructions (F=3.973, p=0.026). However, it was expert agent who earned
higher ratings. Thus the hypothesis 3 was turned down. Generally, participants deemed the
expert agent to be better than the co-learner agent.
As for the expectation that participants with only a co-learner agent will have a different
perception of this agent than participants with a co-learner agent and an expert agent
(hypothesis 3b), it was approved by a T-test (F=5.180, p=0.029) which showed that
24

participants’ ratings of co-learner agent decrease when it was presented together with expert
agent.
Expectation was made that participants with only an expert agent will have a different
perception of this agent than participants with a co-learner agent and an expert agent.
(hypothesis 3c). However, it was not confirmed by a T-test (F=0.714, p=0.403) which showed
that participants’ ratings of co-learner agent did not change much when it was presented
together with expert agent.

4.4 Differences in user experience
User experience consists of four aspects, namely the level of positiveness, satisfaction,
effectiveness and efficiency. The mean score of these four aspects was calculated the results
of the experiment were analyzed through a univariate ANOVA.
Table 11 shows the mean score of user experience in each group.
Table 11 The Mean Score of user experience

Expert
Mean
SD

2.51
0.73

Co-learner

Expert and
Co-learner
2.31
2.4
0.92
0.79

The expectation was that the participants with a co-learner agent will report better user
experience compared to participants with an expert agent and participants with both a colearner and an expert agent. (hypothesis 4). However, by taking the ANOVA test, no general
effects of agent on user experience was found (F=0.299, p=0.743). Hypothesis 4 was not
confirmed.

5. Discussion
This study focused on finding out the possible effects of different types of pedagogical agent.
Aiming to examine the possible impact made by an expert-like agent and a co-learner agent,
twelve hypotheses were put forward as assumptions based on the results of former studies. By
analyzing data collected in experiment, results of these hypotheses were revealed, as shown in
the following table.
Table 12 Conclusion

Hypotheses
Participants with a co-learner agent will have
higher level of effectiveness compared to
participants with an expert agent or two kinds of
Task
agents simultaneously in the task completion
Performance
phase.
Participants with both a co-learner agent and an
expert agent will have higher level of effectiveness
compared to participants with an expert agent or

Results

Not supported

Not supported
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participants with a co-learner agent in the task
repetition phase.

Motivation

Agent
Perception

User
Experience

Participants with both an expert-like agent and a
co-learner agent will spend longer time on
finishing the task compared to participants with
only an expert agent or a co-learner agent in the
task completion phase.
Participants with a co-learner agent and with both
a co-learner agent and an expert agent will have a
higher level of motivation compared to participants
with an expert agent only.
Participants with a co-learner agent will have a
higher level of confidence than participants with an
expert agent and participants with both a co-learner
agent and an expert-agent.
Participants with a co-learner agent will have a
stronger feeling of relevance than participants with
an expert agent and participants with both a colearner agent and an expert-agent.
Participants with a co-learner agent will have a
higher level of satisfaction than participants with
an expert agent and participants with both a colearner agent and an expert-agent.
Participants in multi-agent groups will have a
lower level of attention then participants with a colearner agent and participant with an expert agent.
Participants will give higher ratings to co-learner
agent when co-learner agent and expert agent
coexist in a system.
Participants with only a co-learner agent will have
a different perception of this agent than participants
with a co-learner agent and an expert agent.
Participants with only an expert agent will have a
different perception of this agent than participants
with a co-learner agent and an expert agent.
The participants with a co-learner agent will report
better user experience compared to participants
with an expert agent and participants with both a
co-learner and an expert agent.

Supported

Not supported

Not supported

Not supported

Supported

Not supported

Not supported
Supported

Not supported

Not supported

5.1 Implications
The study showed the effects of co-learner agent and expert-agent on users in terms of
following four constructs: task performance, motivation, agent perception, user experience.
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In this study, no differences were found in terms of effectiveness and efficiency by
implementing different types of pedagogical agent. Although in some studies, agent-based
instruction is proved to result in better learning performance(Eiriksdottir & Catrambone, 2011),
the result of this study is basically in line with the results of some other former researches on
motivational elements(Karreman & Loorbach, 2013; Loorbach et al., 2006). Besides
motivational elements’ limited influence on effectiveness and efficiency, another possible
cause for this phenomenon could be attributed to the task itself. As stated in former
research(Lester, Converse, Stone, & Kahler, 1997), the magnitude of animated pedagogical
agents’ effects on students’ problem-solving performance increase with the level of problem
difficulty. Since the task was limited to be within a certain level of difficulty and was controlled
to contain reasonable amount of information, the possibility of causing a significant difference
in effectiveness and efficiency is relatively small, especially when participants were all welleducated college students who have had easy access to computer as well as various
applications from very young age. A relatively new finding of this study is that agent has no
great effect on the effectiveness in task repetition phase. No matter they were given useful
instructions by expert agent or encouragement by co-learner agent, or instructions together
with encouragement, participants’ completion status of task repetition didn’t differ much.
Perhaps it was too much cognitive load for participants to memorize the complete operating
steps when they were introduced to use Photoshop for the first time and the implementation of
agents is of very minor effect on it.
Hypotheses that participants working with instructions with a co-learner agent will a have
higher level of motivation compared to participants with expert agent only was partly proved.
This conclusion further confirmed the co-learner agent’s effect in terms of motivating users.
Despite the fact that co-learner agent is clearly not equivalent to human peer, its effect on
simulating social interaction in computer-based learning environment has been proved
(Yanghee Kim & Baylor, 2006a). Since peer-peer interaction has been verified to be of great
benefits in terms of learners’ affective attainments(Bandura, 1977), the introduction of colearner agents, especially caring ones, can contribute to the improvement of leaner’s
motivation level. The hypothesis that the implementation of co-learner agent can lead to higher
ratings of satisfaction is verified in the study. As the agent simulating human-peer interaction,
co-learner agent is perceived to be more friendly(Y. Kim et al., 2007; Yanghee Kim & Baylor,
2006b).
In this study, the co-learner agent was designed to give motivation and praise frequently, thus
its perceived level of friendliness might be further improved. However, the presentation of colearner agent is not helpful for the improvement of confidence in this study. The most possible
reason for it might lie in the participants. As it mentioned before, participants in this study are
all college students who have accepted at least undergraduate education. The average age of
these participants is quite young, which means that most of them are raised in environment
with various technology products, including computer. Compared to senior users who are more
easily encouraged by motivational elements, young people are less afraid when they are
exposed to new technology. Thus it would be harder to improve their level of confidence,
which is already very high.
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The other interesting finding in this research is that participants with multiple agents are proved
to be no less attentive than participants in other groups. According to Moreno and Flowerday’s
finding (2006), participants who are more attracted by the agents are more likely to focus on
the social characteristics of the agents, which will lead to interference in the learning process.
Due to the fact that no differences of attention level were found in three groups and relative
high mean score of attention, the most possible explanation is that participants are not very
attracted by pedagogical agents here. It could be caused by the design of pedagogical agent or
by the background of participants. Since users are more inclined to be effected by agent with
their own gender(Baylor & Kim, 2000; Baylor, 2011), it is of great possibility that male
participants were less influenced by pedagogical agents presented in instructions. On the other
hand, college students may be less attracted by pedagogical agents compared to children or
senior users.
As for the perception of agent, expert-like agent was given higher ratings by users, which is
completely opposite to hypothesis. According to the mean scores, the expert-like agent was
of higher level of credibility and knowledge although it was rated with lower level of
attractiveness and friendliness. Since expert agent was with higher overall rating, the
conclusion can be drawn that in this study, the expert agent was deemed to be much more
credible and knowledgeable than co-learner agent. The finding that expert-like agent was of
higher level of credibility further confirms the conclusions of previous studies mentioned in
the theoretical framework part. However, contrary to some previous studies (Y. Kim et al.,
2007; Liew et al., 2013), it was found in this study that expert-like agent is deemed to be more
knowledgeable. This phenomenon may owe to the multi-agent system in which both the expert
agent and co-learner agent were presented. Unlike co-learner agent, expert agent focused on
providing useful information and reminders, which might easily lead to higher ratings of its
knowledge level among users. Due to the same reason, possibly, the ratings of co-learner agent
go down when it was presented in one system together with expert-like agent. However,
another interesting finding to be noticed is that participants’ ratings on expert agents didn’t
change much when it was presented together with co-learner agent. The reason for this
phenomenon is still to be discovered.
It was hypothesized that the instructions of co-learner agent group would result in better user
experience compared to other two groups because co-learner was expected to be more
enjoyable due to previous researches. However, contrary to the hypothesis, it was proved in
this study that user experience is not much altered despite the implementation of different
agents. Since there are very limited researches focusing on the relationship between agent
implementation and user experience, further studies are needed to be conducted in this field.

5.2 Limitations
Some limitations of the design of this study may affect the results, of which, the fact that the
pedagogical agents are just printed on manual as static images might serve as the biggest one.
Without non-verbal communication like facial expressions or gestures, less information related
to agent was conveyed. Since it is proved that both the visual and voice characteristics of
expert-like agent and co-learner agent have certain effects of learners’ psychological
behaviors(Doswell, 2004), the absence of voice information might lead to different
psychological condition of users.
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The other limitation of this study is the lack of investigation into gender difference. According
to previous researches, one essential factor which must be taken into consideration when
investigating the effect of pedagogical is the participants’ gender. With different gender,
learners might have distinct reaction to a same variable. For example, according to Baylor
(2005), female students performed significantly better when using a cartoon agent than male
students, while male students have better perform when they are exposed to highly realistic
pedagogical agent (Baylor, 2005; Sahimi et al., 2010). Moreover, female participants and male
participants tend to have different levels of acceptance of pedagogical agent itself. Research
has proved that female learners were more likely to give better ratings for agents compared to
male learners(Baylor & Kim, 2000). For these reasons, participants’ gender also do make an
impact on their opinion of agents. However, because of the limited number of participants, it
is not possible to classify participants by their gender in each group.
On the other hand, since there are still very limited researches on the measurement of user
experience, the investigation of user experience in this article is not completely scientific.
Further researches are needed in this field.

5.3 Suggestions for future research
Since the participants in this research were all college students, further research can be made
on agent’s effects in different age group such as children or the seniors. Generally,the seniors
are more in awe of technology compared to young people and it will take them longer time to
learn the usage of electronic products. For this reason, it is of great possibility that they will
feel higher level of motivation with the companion of agents. As for children, they tend to be
more attracted by agents compared to adults. Therefore, it is possible that agents’ effects on
children will also be stronger. Furthermore, agent’s effects can be measured among female
users and male users separately so that the possible influence of various agents on users with
different gender can be discovered more clearly.
It is found that studies on agents’ effects on task repetition and user experience are very limited.
Further researches can be made in this field to investigate pedagogical agents’ influences on
cognitive load so that the findings in this research can be better explained.

5.4 Conclusion
As an important factor of agent design, the pedagogical agent role not only is strongly related
to other features of agent such as tone of voice, non-verbal communication and visual image,
but also has direct impact on users. Although both expert-like and peer-like pedagogical agents
are considered to be motivational elements, their effects of motivation differ. Co-learner agents
are perceived to be more motivating than expert-like agent in general and are proved to be
more effective in terms of improving satisfaction level. On the other hand, learners’ perception
about agents might differ due to their stereotypes. An expert agent is given higher ratings due
to the remarkable impressions it has made in terms of being credible and knowledgeable.
Furthermore, no clear proof was found in terms of agents’ impacts on effectiveness and
efficiency. Although the effectiveness of agents are dependent on factors such as learning
context and target learners, it is supported that basically the activation of stereotypic beliefs in
learner’s mind by implementing different agent roles can lead to difference in their
psychological condition as well as learning behaviors.
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Appendix
Instructions with co-learner agent and expert agent
Hello, everyone. Welcome!
My name is Kate and I have several years of experience of using
Photoshop. I will be your mentor in the following course in which you
will learn how to change the background of an image by using channels,
the grayscale images that store different types of information in
Photoshop.
I will instruct you step by step and emphasize the key points for you.
Using Photoshop can be interesting. So, let's begin.
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Hello, everyone.
My name is Kelly and I’m a novice of using Photoshop just like you.
Now we are going to take the challenge to change the background of a
image with the help of Photoshop. It would be nice to learn with you
because we can remind each other of key points when we come across
same kind of problems. I’m not sure whether we can finish the task, but
I’m sure things will go better when we support each other.
So, let’s not wait and start the task right now.

Subtask 1

Goal: Create a new channel in which the subject is covered by
a dull surface.
1. Open the image in Photoshop (File> Open>Desktop>pic.jpg).

2. Select the Channels panel (Windows > Channels). The channels panel will then show in the
right part of the interface as the following figure shows.
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3. Choose Image > Calculations and make sure the Preview box in the right part of the tab is
checked. Since the blue channel in this image shows the greatest difference between subject
and background, it’s now time to add one more channel to the blue channel to create a new
channel based on the color.
It is all about the settings of calculations tab from step 4 to step 6. Please
be careful about your choice and follow the instruction step by step.
Remember, any minor mistake may lead to different outcomes.

It is all about settings of calculations tab from step 4 to step 6. It seems a
little bit complicated. So, we should be attentive and I bet we can do it.

4. In the Source 1 area, set the Channel to Blue
5. In the Source 2 area, Choose Red from the Source 2 pop-up and click the Invert check box to
reverse the details. This will help mask out the subject.
6. Use the Blending menu to combine the Blue and Red channels. Blending is used to control
how two different images or channels blend together based on their color and luminance
values. Different source images need different modes, so you’ll need to click through many
of the modes on the list. In this case, the Linear Burn mode works well to create a matte,
which means a dull surface of the subject.
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7. Click OK to create a new channel in the Channels panel. The channel, should be named
Alpha 1 automatically and it becomes the active selection in the Channels panel (with the
RGB channels turned off, for now). The following figure shows the result of step 7.

The first subtask is mainly about the settings of channels. It lays the
foundation for upcoming subtasks. Be sure to take enough attention on
channels panel because it will be used frequently in the whole task.

Congratulations! We have just finished the first part of the task. It’s not
that difficult, am I right?
Let’s cheer up for the upcoming subtask.

Subtask 2

Goal: Remove the background of the newly created channel to select
the subject.
The quality of accomplishment of this part is strongly related to the
accomplishment of the whole task. It’s really important for you to
correctly execute each step.
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Subtask seems to be the most important part of the whole task. Make
sure that you are ready for this challenge and we can make it!

Step 1 may take a long time because we want to make contrast between
subject and background as sharp as possible. Therefore, we need to be
patient here.

The point of step 1 is to make the contrast between subject and
background as sharp as possible. The settings of input level are not
absolute here.

1. It’s now time to create a clean black and white mask for the new channel. Choose Image >
Adjustments > Levels or press Ctrl+L. Move the White Input Levels slider to the left to
lighten the gray areas to white. Move the Black and Gray Input Levels sliders to refine the
matte and improve contrast between foreground and background. The following figure is an
example of the final setting.
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2. Choose the Brush tool in the toolbar at the left side of screen by clicking the right mouse
button.

3. Click the Set foreground color button in the bottom of toolbar to enter the color picker
window. Set the color of brush to white.
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4. Paint over any areas that need to be removed from the matte as the following figure shows.
You may find it easier to reduce the size of brush by pressing the key
by pressing the key

or improve the size

when necessary.
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5. Once the alpha channel has all holes filled in, Command-click (Ctrl-click) on the alpha
channel thumbnail to load the selection. You’ll see the dotted lines around the whole image
as the following figure shows.

6. Choose Select > Inverse to reverse the selection so the subject is active. You’ll see the dotted
lines around the subject as the following figure shows.

7. Click the visibility icon next to the RGB composite channel to enable it and you’ll see the
following figure. Click on the RGB composite channel so it is the active channel as well.
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Subtask 2 is about selecting the subject so that it can stand out. Now you
need the upcoming subtask to refine the selection.

Now we have successfully finish subtask 2, the most complicated part
of the whole task. I’m sure we can finish the rest parts.

Subtask 3

Goal: Refine the edge of selected subject and remove the background
of the original image.
Subtask 3 focuses on the further refinement of our achievement from
subtask 2. The settings of each parameter are related to the final
outcome. Be sure to make your best choice.

Subtask 3 is relatively simpler than subtask 2. Since we are here, I don’t
think this subtask will be a problem for us.

1.
2.
3.
4.

Choose Select > Refine Edge to improve the selection.
Click the check box next to Smart Radius.
Set the value of radius as 1.4 px.
Click the Output pop-up menu in the Refine Edge dialog and choose New Layer with Layer
Mask.
5. Click the check box next to Decontaminate Colors and click OK. The following figure is an
example of the final settings.
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6. In the Channels panel, disable the visibility of the Alpha 1 Channel to see the results.
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Refining edge of the selected subject is very helpful to improve the
quality of final outcome. As you can see, you have removed the
background of original image perfectly with the help of edge
refinement.

Now we have finished 75% of whole task and we are about to finish the
task successfully!
Let’s work on the final subtask.

Subtask 4

Goal: Change the background.
The final part only contains four steps. Come on, let’s finish it.

The final part is about changing the background of the subject we have
selected. Although it seems that there is not much work to do now, you
still have to be cautious.

1. Click on the RGB composite channel as the following figure shows to make sure the RGB
channel is selected.
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2. Command-click (Ctrl-click) on the Background copy mask channel thumbnail to load the
selection.
3. Press Ctrl + C to copy the selected image.
4. Open the new background image (File> Open>Desktop>pic2.jpg).
5. Press Ctrl + V to paste the subject onto the new background image.

Congratulations. Now you have successfully finished this task.

45

Congratulations. We have made it. Now it no longer will be a problem
for us to change background of image in Photoshop.

Questionnarie
 Motivation
It is clear to me how the content of this instruction manual is related to things I already know.
The quality of the text helped to hold my attention.
As I worked with this instruction manual, I was conﬁdent that I could learn how to use Photoshop.
I enjoyed working with this instruction manual so much that I was stimulated to keep on working.
The way the information is arranged on the pages helped keep my attention.
I really enjoyed working with this instruction manual.
The content and style of writing in this instruction manual convey the impression that being able to
work with Photoshop is worth it.
After working with this instruction manual for a while, I was conﬁdent that I would be able to complete
exercises with Photoshop.
The variety of reading passages, exercises, illustrations, etc., helped keep my attention on the
instruction manual.
The content of this instruction manual will be useful to me.
The good organization of the content helped me be conﬁdent that I would learn to use Photoshop.
It was a pleasure to work with such a well-designed instruction manual.

 Agent perception
I like Kate.
Kate is friendly.
Kate is knowledgeable.
I can trust instructions presented by Kate.
I like Kelly.
Kelly is friendly.
Kelly is knowledgeable.
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I can trust instructions presented by Kelly.

 User experience
Very negative (1):Very positive(5)
Very satisfied(5): Very dissatisfied (1)
Very effective (5): Very ineffective (1)
Very efficient(5) :Very inefficient (1)
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